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Overview

1 Overview

This documentation describes how to install and use Processor Expert in conjunction with the MC34ValveController component.

The MC34ValveController component supports the following analog parts:

+ MC34SB0410: Quad Valve Controller System On Chip
+ MC34SB0800: Octal Valve Controller System On Chip

The TWR-SB0410-36EVB and TWR-SB0800-36EVB tower boards are evaluation platforms based on these chips. See the related user
guides and data sheets for detailed information.
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MC34ValveController Compatibility

2 MC34ValveController Compatibility

2.1 Peripheral Requirements

Peripherals and resource requirements critical to the MCU’s ability to handle a given part are as follows:

* SPI Module is required for communication (Sl, SO, SCLK, CSB)

* GPIO or TPM/FTM timer (PWM, single channel) are required for direct pump motor pre-driver control (PDI, ADIN1)
* GPIO is required for device reset (RSTB)

+ TPM/FTM timer (periodic interrupts, single channel) is required by the flutter current feature

2.2 Supported Devices

The MC34ValveController supports the following devices:
MC34SB0410

» One pump motor pre-driver (up to 16 kHz)

* Four low-side drivers for inductive loads. Channel 1 to 4 serve as current regulators (with Pl regulator) or as PWMs (Pulse Width
Modulators)

+ Two low-side drivers for resistive loads

MC34SB0800
* One high-side driver (to control the fail-safe switch for overall solenoid path)
* One pump motor pre-driver (up to 500 Hz)
» Eight low-side drivers to drives inductive loads. Channel 1 to 4 serve as current regulators (with Pl regulator) or as PWMs (Pulse
Width Modulators)
» One low-side driver for resistive loads
* One high-side driver for general purpose usage

2.3 Supported MCUs

The MC34ValveController supports the MCUs listed in Table 1. The listed MCUs are a subset of MCUs supported by Processor Expert
for Kinetis using the logic device driver (LDD) layer.

Table 1. Supported MCUs

Supported MCUs CodeWarrior Support Kinetis I;::Lgor:tSystem
TWR-KL25Z48M Yes Yes
TWR-KV31F120M No Yes
TWR-KV10Z32 Yes Yes
TWR-K64F120M Yes Yes
TWR-K20D72M Yes Yes
TWR-K22F120 Yes Yes
TWR-K70 Yes Yes
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MC34ValveController Compatibility

See Table 2 for pin compatibility between Valve Controller tower boards and selected MCUs.

Table 2. Pin Compatibility of Valve Controller Tower Boards with Selected MCUs

Pin TWR-KL25Z48M | TWR-KV31F120M | TWR-KV10Z32 | TWR-K64F120M TWR-K20 TWR-K22F120 TWR-K70
Function (1) (1) () () (1) (2) ()

RSTB PTC7 PTB2 PTBO PTE11 PTB22 PTE3 PTEO
MISO PTD3 PTE19 PTD3 PTD3 PTD3 PTD3 PTD14
MOSI PTD2 PTE18 PTD2 PTD2 PTD2 PTD2 PTD13
CSB PTEO PTCO PTE24 PTEO PTC9 PTE25 PTE28
SCLK PTD1 PTE17 PTC5 PTD1 PTD1 PTD1 PTD12
ADIN1/PDI PTD4 PTD4 PTD4 PTA7 PTD4 PTC1 PTA7
Notes

1. Example provided for this MC. See Section 4.2, Downloading the Components and Example Projects, page 14
2. Create a new project based on an existing project and change the pin selection accordingly.

24 Tower Board Settings

Jumper blocks on the TWR-SB0800-36EVB and the TWR-SB0410-36EVB provide a means of configuring the boards for use with
additional MCUs. Jumper settings on the blocks define the routing of chip select SPI signals, the reset signal from the MCU, and the motor
control signal which can either be simple GPIO (low, high) or PWM. On both the TWR-SB0800-36EVB and the TWR-SB0410-36EVB, this
jumper block is labelled J13.

In addition, jumper J10 on the TWR-SB0800-36EVB and J6 on the TWR-SB0410-36EVB selects between 3.3 V and 5.0 V depending on
the requirement of the MCU being used.

Make sure to set jumper J10 or J6 to the proper voltage level and set the jumpers on J13 to the appropriate positions for the selected
MCU. Check the schematic of each tower elevator board to assure all signals are correctly connected. Figure 1 shows the selection
options on the TWR-SB0800-36EVB and the TWR-SB0410-36EVB.

TWR-SB0800-36EVB TWR-SB0410-36EVB
J13 J13
GPIO1 1 2 PWMO GPIO1 1 2 PWMO
319974 31994
SB0800_RESET ), P02 5 Ot5 Sia<< SBO800_ADIN1 SB0410_RESET ), P02 5 Ot5 S SB0410_PDI
GPIO8 712978 PWMT GPIO8 72978 PWMT
o o
9 o 10 9 o 10
GPI09 11 o 12 PWM5 GPI09 11 ol 12 PWM5
13 14 GPIO8 13 14 GPIO8
SB0800_CSB oPios Y 15 Ot SB0410_CSB ) cPios Y 15 Ot
17 g 18 GPIO3 17 g 18 GPIO3
GPIO2 19 ol 20 GPIO2 19 o 20
HDR_2X10 HDR_2X10

Figure 1. Jumpers for 10 Selection

Table 3 shows appropriate J13 jumper settings for compatible tower boards. These settings are important because the Reset (RSTB) and
Chip Select (CSB) signals must be routed to MCU IO header positions capable of handling such signals. Note that the ADIN1 pin on the
MS34SB0800 can be used either to directly control the Pump Motor Pre-Driver or to measure external voltage. The PDI pin controls the
Pump Motor Pre-Driver on the MC34SB0410.

Table 3. MCU Tower Board Jumper Selection

TWR-KL25Z48M | TWR-KV31F120M TWR-KV10Z32 TWR-K64F120M TWR-K20 TWR-K22F120 TWR-K70
RSTB GPIO1 GPIO1 GPIO1 GPIO1 GPIO8 GPIO1 GPI102
CSB GPI02 GPI102 GPI102 GPI102 GPIO9 GPI02 GPIO3
ADIN1 PWM4 PWM4 PWM4 PWM4 PWM4 PWMO PWM4
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MC34ValveController Component

3 MC34ValveController Component

The MC34ValveController is located under the Components folder in the active projects window (see Figure 2). This folder contains two

sub-folders: Referenced_Components (containing components to configure SPI communication properties) and

VC1:MC34ValveController (containing the component to configure MC34SB0800 and MC34SB0410 features). The functionality of the

MC34ValveController depends on the component property settings assigned through Processor Expert.

5. Components - VC_KL25Z_4VAPS _DriverMenito... &3 & <

4 (= Generator_Configurations
@ FLASH
= 0Ss
4 (= Processors
&P Cpu:MKL25Z128VLK4
4 (= Components
(= Referenced_Components
4 [ VC1:MC34ValveController
3 SPI_Devicel:SPI_Device
%) RSTB1:BitIO_LDD
@8 CtrlPin2:BitI0 LDD

M Init

[ Deinit AP
[ WriteRegister

[ ReadRegister

[ GetControllerStatus
[ ClearDriverFault

M SetDriverState

B SetPDPWMDut

B SetLSD
[ SetLSDPWMFrequency
[ SetLSDCurrent

[ SetPIRegulator

T GetL.SDPWMDuty

B GetLSDCurrent

M GetADCValue

B FeedWatchdog

M GetLSDMode

[ GetResetPinVal

PWMDut

B FlutterCurrent
{2 CsI01:Consolel0
= PDD

Figure 2. MC34ValveController Processor Expert Component
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The component also offers Help documentation, which can be accessed by right-clicking on the MC34ValveController in the component
tree. The Help on Component window provides information on all properties and methods of the component. Access the Typical Usage

section to view examples showing how to work with APl methods.

MC34ValveController Processor Expert Component, Rev. 1.0

NXP Semiconductors



3.1 Component Settings

Selecting the MC34ValveController component in the component tree gains access to properties in the Component Inspector. These
properties determine the component’s general settings and its behavior after initialization. Application code can later change some of these

properties using the provided API.

Mame
Component Name
4 Valve Controller Model
4 General Settings
Reset Pin
Discharge Slew Rate
Clock Frequency
Internal Clock Monitoring
HS for Fail-safe Switch
a LSD for Inductive Loads
Rise Time and Fall Time
Open Load Detection
a PWM Frequency
Frequency of L5D1 -4
Frequency of LSD 5 -8
a Current Regulation Mode
4 PI Regulator
P - Characteristic
I- Characteristic
Integrator Limit
Minimum PWM Duty
First PWM Duty
- Flutter Frequency Settings
4 L5D1
Maximum Current
4 Control Mode
Target Current
- Flutter Frequency
- LSD 2
a4 LSD3
4 Control Mode
PWM Duty
LSD 4
. LSD 5
. LSD 6
LSD7
- LSD 8
- Pump Motor Pre-driver
LD 1 for Resistive Charge
HS for General Purpose
Initialization Behavior
Auto Initialization

Figure 3. Valve Controller Component Properties

Value
va
MC345B0800

CMPO_IN1/PTCT/SPI0_MISO/SPI0_MOSI
Slow

Fixed

Enabled

On

Leng
Enabled

3.9 kHz
3.0 kHz

1

0125

Low

10%

Controlled by Current

750.0

Current Regulation
0.0

Disabled

PWM

Disabled

Off

Off
MNon-blocking
no

MC34ValveController Component

Valve Controller Model (MC34SB0410 / MC34SB0800) - This component supports two models of the Valve Controller. Both have much
in common, but differ in number and type of provided drivers. Therefore model selection affects which properties are available/hidden, or

enabled/disabled.

General Settings

* Reset Pin - This pin has dual functionality. It can be used for an explicit reset of the device, in which case it works as an output.

Alternatively, it can be used as a fault indication in which case it works as an input. The direction of this pin is automatically handled
by the component.

Discharge Slew Rate - The slew rate used by the pump motor pre-driver and high-side driver for general purpose modules. When
the power FET is switched off, the gate capacitance of the FET is discharged by a constant current that is controlled as either fast
(typically 2.0 mA) or slow (typically 100 pA). This feature is available for MC34SB0800 only.

Clock Frequency - The frequency of the clock modules, i.e. the main supply clock (CLK1) and the auxiliary clock (CLK2). Clock
frequency is 14 MHz when the fixed option is selected. Otherwise frequency modulation is used. Two deviation frequencies (350 kHz
and 700 kHz) are available to spread the oscillator energy over a wide frequency band.

Internal Clock Monitoring - The internal clock monitoring function (i.e. enable or disable CLK2). Valve Controller utilizes two clocks:
the main supply clock (CLK1) and the auxiliary clock (CLK2). CLK2 monitors main clock faults and resets the controller (using the
RST_CLK function) when a fault is detected. Disabling CLK2 has no effect on other functionality (except for the clock monitoring
function) because the main clock (CLK1) remains active.

MC34ValveController Processor Expert Component, Rev. 1.0
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MC34ValveController Component

HS for Fail-safe Switch - The initial state of the high-side driver intended to control the fail-safe switch for the overall solenoid path.
(Available on the MC34SB0800 only)
LSD for Inductive Loads

* Rise Time and Fall Time - The rise time and fall time of the low-side drivers. Long rise and fall times are typically 1.7 us (rise) and
1.35 us (fall). Short rise and fall times are typically 0.5 s (rise) and 1.0 ps (fall).

+ Open Load Detection - Enables or disables sink current for open load detection

PWM Frequency

* Frequency of LSD 1—4 - From 3.0 kHz to 5.0 kHz.

* Frequency of LSD 5—8 - This setting is available for the MC34SB0800 only.

Current Regulation Mode - The current regulation mode setting for low-side drivers. Load current is sensed by the internal low-side
sense FET and digitized by the internal A/D converter. The digital current regulation circuitry compares the actual load current with the
target current value and steers the low-side power switch duty cycle. The Pl regulator is used.

* Pl Regulator

— P - Characteristic - The proportional characteristic of the PI regulator.

— | - Characteristic - The integral characteristic of the PI regulator. The regulator stays idle until a non-zero value is
applied.

— Integrator Limit - The set integrator limit. Possible values are low (1023) and high (2047).

*  Minimum PWM Duty - The minimum duty cycle of the low-side driver (1 to 4) outputs. This option applies to the time interval during
which the current measurement occurs. Note that the maximum duty cycle is 100%.

+ First PWM Cycle - The first duty cycle of the low-side driver (1 to 4) outputs. The first duty cycle is either controlled by current or
limited to a fixed duty cycle in which the target current is transformed.

Flutter Frequency Settings - The setting of the flutter current function, which influences mechanical friction inside the valve. The goal is
to achieve a more precise movement. When this function is used, current is changed periodically around the target current. This results
in the current varying as a sine wave. This property is enabled automatically by the component when enabling the flutter current feature
for one or more LSDs. See Section 3.6, Flutter Current Feature, page 12.

» Timing Device - The name of the timing device used by Timerint_LDD component.

» Control Mode - The control mode for the flutter current function. Auto means the process is automatically handled internally. Polling
means the user application code must call handler functions to achieve the desired behavior.

LSD 1 - 4 - The common settings for current regulation or PWM mode

* Maximum Current - The current limitation value in mA. This value is used in component methods.

» Control Mode - Current Regulation/PWM) - Sets the low-side driver mode. Either current regulation or PWM mode can be enabled
in time.

» Target Current - Target current in mA. Minimum value is 0 mA, maximum 2250.6 mA and step is 2.2 mA. The value is rounded to
the nearest available value.

* Flutter Frequency - Enables or disables flutter current feature for selected the LSD.

— Frequency - The frequency of the sinusoidal current curve in Hz. When the flutter current function is used by two or
more LSDs, the frequency value is corrected, because it must fit the interrupt frequency given by the LSD with the
maximum flutter frequency.

— Points per Period - The number of points per period. Single point corresponds to the deviation of current given by the
actual position on the sinusoidal curve.

—  Amplitude - The amplitude of the sinusoidal curve in mA. This value defines the maximum variation from the target
current. The admissible range is from 5.0 mA to 100 mA.

* PWM Duty - The target PWM duty cycle. The admissible range is from 0 to 255. Representing 0% respective 100% duty value.

LSD 5 - 8 - The common settings (only PWM mode) - These drivers are available on MC34SB0800 only.
+ PWM Duty - The target PWM duty cycle. The admissible range is from 0 to 255. Representing 0% respective 100% duty value.
Pump Motor Pre-driver - The settings of the Pump Motor Pre-driver.

» Overcurrent Masking Time - The masking time from the direct input turn-on against the malfunction on transient time. This masking
time is used by the over-current detection logic. Possible values depend on the selected valve controller model.

» Overcurrent Filter Time - The overcurrent filter time of the pump motor pre-driver. The drain-source voltage of the FET on PD_G is
checked when the pre-driver is switched on. If the measured voltage exceeds the overcurrent voltage threshold, output of the
comparator is enabled. If the output of the comparator is active longer than the defined filter time, PD_G is turned-off. For the
MC34SB0410, the filter time has a fixed value. This setting is available for MC34SB0800 only.

« Control Mode - SPI/Direct) - The pre-driver can be driven either directly by the MCU pin or through the SPI interface.

— Initial State - The initial state of the driver output in SPI control mode.

— Input Control - GPIO/PWM) - The type of direct control mode. The possible values are GPIO (general purpose
input/output pin) or PWM (pulse width modulated).

MC34ValveController Processor Expert Component, Rev. 1.0
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MC34ValveController Component

+  Control Pin - The pin for direct control. This pin is called PDI for MC34SB0410 and ADIN1 for MC34SB0800. Note
that if ADIN1 pin is used for direct control, it cannot be used to measure the external voltage simultaneously. To use
ADIN1 for measurement, set the Pump Motor Pre-driver Control Mode to the SPI.

+  PWM Frequency - The PWM frequency. The maximum value depends on the valve controller model (16 kHz for
MC34SB0410, 500 Hz for MC34SB0800).

+  PWM Duty - The target PWM duty cycle. The admissible range is from 0 to 255. Representing 0% respective 100%

duty value.
+ Initial State - The initial state of driver output in direct control mode.
» LD 1 for Resistive Charge - The initial state of the low-side driver 1 for a resistive charge.

» LD 2 for Resistive Charge - The initial state of the low-side driver 2 for a resistive charge. This setting is available for the

MC34SB0410 only.

HS for General Purpose - The initial state of the general purpose high-side driver. This setting is available for the MC34SB0800 only.
Initialization Behavior - Defines the behavior of the Init method. This method selects between internally blocking and unblocking while
waiting on the Reset pin to clear. If blocking version is selected, the method may hang if an error fails to clear. If the unblocking version is

selected, the method uses a timeout functionality to avoid infinite waiting.

Auto Initialization - Selects whether component initialization should be automatically called from the CPU component initialization

function PE_low_level_init or whether the user is responsible for calling the initialization method.

3.2 SPI Configuration

The Valve Controller uses the SPI communication protocol to communicate with the MCU. This protocol is implemented by the
SPIMaster_LDD component which can be found in the referenced components (shared components) folder in the Components panel (see
Figure 2). However, this component does not handle arbitration for simultaneous communication requests on the SPI bus. This
functionality is implemented by the SPI_Device component, which is exclusively inherited by the MC34ValveController component.

In SPIMaster_LDD, the (MISO, MOSI, CLK) pins and timing settings must be set according to MC34SB0410/MC34SB0800 data sheet

recommendations. The maximum admissible communication frequency is 10 MHz.

The CSB (chip select) pin has to be set separately in the BitlO_LDD component exclusively inherited by SPI_Device. Because of
component implementation limitations, the user must initialize the CSB pin value to 1 as specified in the data sheet.

MName

Device
Interrupt service/event
4 Settings
4 Input pin
Pin
4 Output pin
Pin
a Clock pin
Pin
Chip select list
4 Attribute set list
4 Attribute set 0
Width
M3SE first
Clock polarity
Clock phase
Parity
Chip select toggling
Clock rate index
Clock rate
4 Initialization
Auto initialization

Value

SPI0
Enabled

Enabled
PTD3/SPI0_MISO/UART2_TX/TPMO_CH3/SPI0_MOSI
Enabled
PTD2/SPI0_MOSL/UART2_RX/TPMO_CH2/5PI0_MISO

ADCO_SESk/PTD1/SPI0_SCK/TPMO_CHL
0

5.24288 MHz

Figure 4. SPI Configuration

3.3 Component API

The Valve Controller component provides API functions allowing the application code to dynamically configure a device in real-time. The
available methods and events can be viewed by clicking to expand the component in the Component folder of the Components Panel (see

Figure 2).
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MC34ValveController Component

Some of those methods/events are marked with ticks and others with crosses, which distinguishes which methods/events are supposed
to be generated. Change this setting in the Processor Expert Inspector. Note that methods with grey text are always generated because
they are needed for proper functionality. This forced behavior depends on various combinations of component property settings. For
summarization of available APl methods and events and their descriptions, see Table 4.

Table 4. MC34ValveController Component API

Method Description
Init Initializes the device and applies settings selected in the component properties. This includes initialization of inherited
components and other features.
Deinit Deinitializes the device. Sets the reset pin to low and consequently clears all registers of device.
WriteRegister Writes a value to the selected register. Allocates the SPI bus and calls the internal function VC_write_register.
ReadRegister Reads a value from the selected register. Allocates the SPI bus and calls the internal function VC_read_register.

GetControllerStatus

Gets status information, reads two registers with related information.

ClearDriverFault

Clears selected fault flags. Handles only faults related to the driver's modules. It is not intended to clear supervision mod-
ule faults.

Sets the selected driver output state. Internally handles the driver either through SPI communication or directly by output

SetDriverState of the MCU.

SetPDPWMDuty Sets the PWM duty cycle for the pump motor pre-driver when the direct control mode is used.

SetLSDPWMDuty Sets the PWM duty cycle for the selected low-side driver for inductive loads. LSD has to be in PWM mode.
SetLSDPWMFrequency Sets the PWM frequency for the selected group of low-side drivers for inductive loads.

SetLSDCurrent Sets the target current for the selected low-side driver for inductive loads. LSD has to be in current regulation mode.

SetPIRegulator

Sets parameters of HW PI regulator used for LSDs in current regulation mode.

GetLSDPWMDuty Gets PWM duty cycle of selected LSD, which has to be in current regulation mode.
GetLSDCurrent Gets measured current of selected LSD, which has to be in PWM mode.

GetADCValue Reads and interprets ADC value of selected measured item (temperature, voltage) by device.
FeedWatchdog Feeds watchdog. Sends MCU monitoring result computed for LFSR output received from device.
GetLSDMode Gets mode (current regulation, PWM) for selected LSD.

GetResetPinVal Gets level of reset pin. Low level means that device is in fault state.

FlutterCurrent

Checks whether to adjust target current of LSDs with enabled flutter current feature according to predefined settings.

MC34ValveController Processor Expert Component, Rev. 1.0

10

NXP Semiconductors



MC34ValveController Component

3.4 MC34ValveController Components

The MC34ValveController consists of the valve controller component, which allows configuring MC34SB0800 and MC34B0410
capabilities, and a set of referenced components, which configure SPI communication functions. Figure 5 illustrates these components
and their relationship to each other. A description of the inherited and referenced components used by the MC34ValveController appears
immediately below Figure 5. The functionality of the MC34ValveController in terms of communication, control, etc. depends on these
components.

MISO, MOSI, SCLK

MC34ValveController Component

SPI_Device

SPI_Master_LDD - _ Timerint_LDD TimerUnit LDD

(SPIO) - BitlO_LDD > —

cs (Flutter current feature) (TPMO)

PD Control
«——| BIitlo_LDD

ReTE TimerUnit_LDD

PWM_LDD > fmertinit_

- (TPM1)

BitlO_LDD
PDI / ADIN1

Figure 5. Components used by the MC34ValveController

Referenced components

SM1:SPIMaster_LDD Configuration of SPI communication—Referenced by SPI_Device
TU1:TimerUnit_LDD Referenced by FlutterFreq1:Timerint_LDD
TU2:TimerUnit_LDD Referenced by CtrlPin1:PWM_LDD

VC1:MC34ValveController components

SPI_Device1:SPI_Device Adds bus allocation of SPI communication

CSPin1:BitlO_LDD Software chip select

RTSB1:BitlO_LDD Input/output reset pin

FlutterFreq1:Timerint_LDD Flutter current feature, periodic interrupts

CtrIPin1:PWM_LDD or Direct control of pump motor pre-driver. Either PWM or on/off logic

CtrlPin1:BitlO_LDD

MC34ValveController Processor Expert Component, Rev. 1.0
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MC34ValveController Component

3.5 Fault Detection and Handling

The Valve Controller component provides methods allowing application code to read device status information and react to faults. Table 5
lists these methods and their functionality.

Table 5. Valve Controller Methods

Method Function
VC_GetControllerStatus() Reads status information related to drivers.
VC_ClearDriverFault() Clears faults related to the driver module.

VC_GetGetResetPinVal()

Reads fault information provided by the supervision module.
VC_GetControllerStatus()

VC_Init() Recovers from a fault that caused a register reset and sets reset pin to low.

3.6  Flutter Current Feature

Under constant current conditions, mechanical friction inside a valve may result in movement less precise than expected. The Flutter
Current feature helps smooth out valve movement by introducing periodic minor deviations from the target current. These deviations are
both above and below the target so the overall current average matches the target current.

80Hz to 400H

Current 1

Average —
Current

Amplitude 5mA to 100mA

Time

Figure 6. Flutter Current Function

As Figure 6 shows, the parameters of this function are frequency (of the base sinusoidal wave), resolution (the number of current changes
per period) and amplitude (the maximum current deviation). The flutter current parameters have the following limitations and admissible
ranges:

Frequency - 80 Hz to 400 Hz

Resolution - 8.0 to 48 points (with step 4)

Amplitude - 5.0 mA to 100 mA
Notice that the final current change frequency equals the sinusoidal curve frequency multiplied by the selected resolution.
To efficiently manage interrupt resources, only a single timer interrupt is used for all LSDs when the flutter current function is enabled. This
introduces a dependency among the LSD flutter frequencies in which the sum of all flutter frequencies must equal the maximum flutter

frequency. This restriction is enforced by component logic adjusting frequencies accordingly. Table 6 shows the specified ranges of
parameters in terms of the timer interrupt requirements.

MC34ValveController Processor Expert Component, Rev. 1.0
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MC34ValveController Component

Table 6. Requirements on MCU Interrupts

Interrupt Frequency (Interrupts per Second)
Frequency (Hz)
8 Points 16 Points 24 Points 32 Points 40 points 48 Points
80 640 1280 1920 2560 3200 3840
100 800 1600 2400 3200 4000 4800
120 960 1920 2880 3840 4800 5760
140 1120 2240 3360 4480 5600 6720
160 1280 2560 3840 5120 6400 7680
180 1440 2880 4320 5760 7200 8640
200 1600 3200 4800 6400 8000 9600
220 1760 3520 5280 7040 8800 10560
240 1920 3840 5760 7680 9600 11520
260 2080 4160 6240 8320 10400 12480
280 2240 4480 6720 8960 11200 13440
300 2400 4800 7200 9600 12000 14400
320 2560 5120 7680 10240 12800 15360
340 2720 5440 8160 10880 13600 16320
360 2880 5760 8640 11520 14400 17280
380 3040 6080 9120 12160 15200 18240
400 3200 6400 9600 12800 16000 19200

There are two ways to implement this feature in your application code:

1. Select Auto as the value for the Control Mode property under Flutter Frequency, in which case all of the flutter current functions
are handled automatically. With Auto selected, current changes take place directly in the internal interrupt routine. This solution is
considered more precise in terms of current change timing because the code is executed with the priority of a raised interrupt
routine.

2. Select Polling as the value for the Control Mode property under Flutter Frequency, in which case the application code is
responsible for checking whether it is necessary to enable the flutter current functions. With Polling selected, an internal interrupt
routine raises a flag indicating the maximum final flutter current frequency. Application code must continually call the
FlutterCurrent APl Method to check the status of this flag and must call the internal flutter current feature handler when needed.
This solution is considered less precise in terms of current change timing because the code executes with user application code
priority and therefore may occasionally be interrupted.

Note that the precision and performance of this function depends on the frequency of SPI communication and the CPU clock.

3.7 Known Issues
The MC34ValveController component has following issues which must be taken in consideration before usage.

1. The Flutter Current (Flutter Frequency) function cannot share the TimerUnit_LDD component (a timer) with the pump motor
pre-driver when the driver is in PWM mode.

MC34ValveController Processor Expert Component, Rev. 1.0
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Installing the Processor Expert Software

4 Installing the Processor Expert Software

This chapter describes the installation of Kinetis Design Studio and the use of Processor Expert for application development. Processor
Expert software is available as part of the CodeWarrior Development Studio for Microcontrollers, Kinetis Design Studio or as an
Eclipse-based plug-in for installation into an independent Eclipse environment (Microcontroller Driver Suite). For more information about
Processor Expert refer to this link:
www.nxp.com/products/software-and-tools/software-development-tools/processor-expert-and-embedded-components:BEAN_STORE _
MAIN?fsrch=1&sr=1&pageNum=1.

4.1 Installing Kinetis Design Studio

This procedure explains how to obtain and install the latest version of Kinetis Design Studio (version 3.0.0 in this guide). The procedure
for CodeWarrior installation is very similar.

NOTE
The component and some examples in the component package are intended for CodeWarrior 10.6
(or above) and Kinetis Design Studio 3.0.0 (and above). If CodeWarrior 10.6 and Kinetis Design
Studio 3.0.0 are already installed on the system, skip this section.

1. Obtain the latest Kinetis Design Studio 3.0.0 installer file from the Freescale website here:
www.nxp.com/products/software-and-tools/run-time-software/kinetis-software-and-tools/ides-for-kinetis-mcus/kinetis-design-studi
o-integrated-development-environment-ide:KDS_IDE

2.Run the executable file and follow the instructions.

4.2 Downloading the Components and Example Projects

The examples used in this section are based on a pre-configured CodeWarrior project. To download the project and its associated
components:

1. Go to the NXP website www.nxp.com/MC34VALVECONTROLLER-PEXPERT
2. Download the zip file containing components and example projects.

3. Unzip the downloaded file and check to see that the folder contains the files listed in Table 7.

Table 7. MC34ValveController Example Project and Components

Folder Name Folder Contents

Components

MC34ValveController_b160104.PEupd | This component configures MC34SB0800 and MC34SB0410 features.

SPI_Device_b1401.PEupd This component configures SPI communication properties.

CodeWarrior Examples

. This project demonstrates the use of the MC34ValveController component in conjunction with MC34SB0410
VC_KL25Z_4VAPS_DriverControl valve controller drivers. The target MCU is the TWR-KL25Z48M.

. I This project demonstrates how to monitor status of the MC34SB0410 valve controller using
VC_KL25Z_4VAPS_DriverMonitoring MC34ValveCotontroller component. The target is the TWR-KL25248M MCU board.

This project shows how to use Flutter Current function to control low-side drivers for inductive loads using
VC_KL25Z_4VAPS_FlutterCurrent MC34ValveController component. The targets are the MC34SB0410 device and the TWR-KL25Z48M MCU
board.

. This project shows how to work with drivers of MC34SB0800 valve controller using MC34ValveController
VC_KL25Z_8VAPS_DriverControl component. The target MCU is the TWR-KL25Z48M.

. I This project shows how to use the MC34ValveController component to monitor MC34SB0800 valve controller
VC_KL25Z_8VAPS_DriverMonitoring | ¢ia11c The target is the TWR-KL25248M MCU board.

This project shows how to use Flutter Current function to control low-side drivers for inductive loads using the
VC_KL25Z_8VAPS_FlutterCurrent MC34ValveController component. The target is the MC34SB0800 device and the TWR-KL25Z48M MCU
board.

Kinetis Design Studio Examples

. This demo project shows how to work with drivers of MC34SB0410 valve controller using
VC_K20D72M_4VAPS_DriverControl | \1~a4v/alveController component. Target MCU is TWR- K20D72M.

MC34ValveController Processor Expert Component, Rev. 1.0
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Table 7. MC34ValveController Example Project and Components (continued)

Folder Name

Folder Contents

VC_ K20D72M
_4VAPS_DriverMonitoring

The purpose of this project is to show how to monitor status of MC34SB0410 valve controller using
MC34ValveCotontroller component. It is intended for TWR- K20D72M MCU board.

VC_ K20D72M _4VAPS_FlutterCurrent

This example project shows how to use Flutter Current function to control low-side drivers for inductive loads
using MC34ValveController component. It is intended for MC34SB0410 device and TWR- K20D72M MCU
board.

VC_ K20D72M _8VAPS_DriverControl

This demo project shows how to work with drivers of MC34SB0800 valve controller using
MC34ValveController component. Target MCU is TWR- K20D72M.

VC_ K20D72M
_8VAPS_DriverMonitoring

The purpose of this project is to show how to monitor status of MC34SB0800 valve controller using
MC34ValveCotontroller component. It is intended for TWR- K20D72M MCU board.

VC_ K20D72M
_8VAPS_FlutterCurrent

This example project shows how to use Flutter Current function to control low-side drivers for inductive loads
using MC34ValveController component. It is intended for MC34SB0800 device and TWR- K20D72M MCU
board.

VC_KL25Z_4VAPS_DriverControl

This demo project shows how to work with drivers of MC34SB0410 valve controller using
MC34ValveController component. Target MCU is TWR-KL25Z48M.

VC_KL25Z_4VAPS_DriverMonitoring

The purpose of this project is to show how to monitor status of MC34SB0410 valve controller using
MC34ValveCotontroller component. It is intended for TWR-KL25Z48M MCU board.

VC_KL25Z_4VAPS_FlutterCurrent

This example project shows how to use Flutter Current function to control low-side drivers for inductive loads
using MC34ValveController component. It is intended for MC34SB0410 device and TWR-KL25Z248M MCU
board.

VC_KL25Z_4VAPS_FlutterCurrentAut
o

This example project shows how to use Flutter Current function in automatic mode. It is intended for
MC34SB0410 device and TWR-KL25Z48M MCU board.

VC_KL25Z_4VAPS_FreeMASTER

This project demonstrates features of MC34SB0410 valve controller with TWR-KL25Z48M MCU board. It
uses FreeMASTER tool for visualization and control. Latest Freemaster installation package:
http://www.nxp.com/products/power-management/wireless-charging-ics/freemaster-run-time-debug-
ging-tool:FREEMASTER

VC_KL25Z_4VAPS_SW_PID_Current
Regulation

Example of PID current regulation driven by TWR-KL25Z48M MCU board with use of MC34SB0410 valve
controller.

VC_KL25Z_8VAPS_DriverControl

This demo project shows how to work with drivers of MC34SB0800 valve controller using
MC34ValveController component. Target MCU is TWR-KL25Z48M.

VC_KL25Z_8VAPS_DriverMonitoring

The purpose of this project is to show how to monitor status of MC34SB0800 valve controller using
MC34ValveCotontroller component. It is intended for TWR-KL25Z48M MCU board.

VC_KL25Z_8VAPS_DriverMonitoring_i
ar

The purpose of this project is to show how to monitor status of MC34SB0800 valve controller using
MC34ValveCotontroller component. It is intended for TWR-KL25Z248M MCU board and IAR compiler instead
of GNU C.

VC_KL25Z_8VAPS_FlutterCurrent

This example project shows how to use Flutter Current function to control low-side drivers for inductive loads
using MC34ValveController component. It is intended for MC34SB0800 device and TWR-KL25Z248M MCU
board.

VC_KL25Z_8VAPS_FlutterCurrentAuto

This example project show how to use Flutter Current function in automatic mode. It is intended for
MC34SB0800 device and TWR-KL25Z48M MCU board.

VC_KL25Z_8VAPS_FreeMASTER

This project demonstrates features of MC34SB0800 valve controller with TWR-KL25Z248M MCU board. It
uses FreeMASTER tool for visualization and control. Latest Freemaster installation package:
http://www.nxp.com/products/power-management/wireless-charging-ics/freemaster-run-time-debug-
ging-tool:FREEMASTER

VC_KL25Z_8VAPS_PD_SPI_PWM

The purpose of this example project is to show how to implement PWM for Pump Motor Pre-driver when SPI
control is used.

VC_KL25Z_8VAPS_SW_PID_Current
Regulation

Example of PID current regulation driven by TWR-KL25Z48M MCU board with use of MC34SB0800 valve
controller.

VC_KV31F_4VAPS_DriverControl

This demo project shows how to work with drivers of MC34SB0410 valve controller using
MC34ValveController component. Target MCU is TWR- KV31F120M.

VC_KV31F_4VAPS_DriverMonitoring

The purpose of this project is to show how to monitor status of MC34SB0410 valve controller using
MC34ValveCotontroller component. It is intended for TWR- KV31F120M MCU board.

MC34ValveController Processor Expert Component, Rev. 1.0
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Table 7. MC34ValveController Example Project and Components (continued)

Folder Name

Folder Contents

VC_KV31F_4VAPS_FlutterCurrent

This example project shows how to use Flutter Current function to control low-side drivers for inductive loads

using MC34ValveController component. It is intended for MC34SB0410 device and TWR- KV31F120M MCU
board.

VC_KV31F_8VAPS_DriverControl

This demo project shows how to work with drivers of MC34SB0800 valve controller using
MC34ValveController component. Target MCU is TWR- KV31F120M.

VC_KV31F_8VAPS_DriverMonitoring

The purpose of this project is to show how to monitor status of MC34SB0800 valve controller using
MC34ValveCotontroller component. It is intended for TWR- KV31F120M MCU board.

VC_KV31F_8VAPS_FlutterCurrent

This example project shows how to use Flutter Current function to control low-side drivers for inductive loads

using MC34ValveController component. It is intended for MC34SB0800 device and TWR- KV31F120M MCU
board.

4.2.1 Import the MC34ValveController Components into the Processor Expert

Library

1. Launch Kinetis Design Studio. When the Kinetis Design Studio IDE opens, go to the menu bar and click Processor Expert ->

Import Component(s).

2. In the pop-up window, locate the component file (.PEupd) in the folder MC34ValveController_PEx_SW\Component. Select
MC34ValveController_bxxxx.PEupd and SPI_Device_bxxxx.PEupd files then click Open (see Figure 7).

# C/C++ - Kinetis Design Studio - C:\Users\b52384\workspace kds_300_valve (=5 e
File Edit Source Refactor Mavigate Search Project Run | Processor Expert | Window Help
- [ viw bt g ey Show Views i
= e = Hide Views S AN | Hgl C/C++ | 4 Debug
I Import Component(s) I ' -
[ ProjectExplo.. 22 7 B 4y ComponentInspector 5% -8 -
=] % Open —— 8=
@-v-vl . « MC34ValveControll.. » Compeonents - |“‘f|| Search Components P' ﬂ
Organize = MNew folder = -~ 0 {@3 e
= =
E - MName Date modified
-« Favorites e
| MC34ValveController_bl1501.PEupd
4 Libraries || SPI_Device_b1401.PEupd
: Documents
tz. Components 3. Music
=/ Pictures
E Videos
1M Computer
il
o U
R Network ~
< m s
File name: "MC34ValveController b1501.PEu v | Processor Expert Update packac -
I Open I Cancel
0 items selected RTINS l |

Figure 7. Import the MC34ValveController Components

MC34ValveController Processor Expert Component, Rev. 1.0

16

NXP Semiconductors




Installing the Processor Expert Software

3. If the import is successful, the MC34ValveController component appears in Components Library -> SW -> User Component (see
Figure 8). The component is now ready to use.

% C/C++ - Kinetis Design Studio - C:\Users\b52384\workspace kds_300_valve =a] X
File Edit Source Refactor MNavigate
- S @ein| &l g S @it 00 -imE
f e e S Quick Access | it ‘ Fg C/C++ | 45 Debug
LQ Project Explorer &2 = 0 % Compoenent Inspector % Components Library &4 = 5‘
Bg|e ~ oz
Alphabetical Categories . Processors| Board Configurations o
®
? All repositories * | | Applicable to project -
P pp! B E
Component Description * 5‘
> (= BC 1
» [ Kinetis -
y = e
% Components = g & Legacy User Components
» (= My Components | B
E ¥ 4 (= MyRepositary i
4 = Software
4 [~ User Components 5
@ MiC34ValveController  Valve Controller System Supporting MC345B0410 and MC345B0800 _
SPI Device Communication with SPI device placed on 5P bus - =
Ne project focused, filtering disabled

Figure 8. MC34ValveController Component Location After Importing to Kinetis Design Studio
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4.2.2 Importing an Example Project into Kinetis Design Studio

The following steps show how to import an example from the downloaded zip file into Kinetis Design Studio.

1.1n the Kinetis Design Studio menu bar, click File -> Import... In the pop-up window, select General -> Existing Projects into
Workspace and click Next.

& C/C++ - Kinetis Design Studio - C:\Users\

Edit Source Refactor MNavigate Search Project Run Processor Expert Window Help
Hew AteshiftsN> [G-ids > O~ Q- Q@~®™E §~
Open File... Quick Access * ¢ | [FETF/F ) 4% Nehua
. & Import l (5
Close Ctrl+W "
onents Libr
Close All Ctrl+ Shift+W Select \
Save CileS oard Config | Create new projects from an archive file or directory. E “ 5
Save As... All reposi
Save All Ctrl+Shift+5 Select an import source:
Descriptio
Revert type filter text
Mave... 4 = General -
Rename. B2 rchive File
Existing Projects into Workspace
Refresh F5 —
(-, File System
Convert Line Delimiters To 3 [T] Preferences
Print... CerleP B e i =
Vakve Conf > (= Cempenent Development Envirenment
Switch Workspace 3 Communi > (= CVS
Restart > (= Git
> (= Install
Import... 1 o [ Processor Expert E
Export... > [= Project of Projects
: [ Remote Systems
Properties Alt+Enter : (= RPM
. = Run/Nehon 3
1VCl.c [VC_KL25Z_8VAPS_DriverMonitor...]
2 main.c [VC_K20072M_8VAPS DriverMoni...]
3 main.c [VC_K20D72M_8VAPS_DriverMoni...]
4 FSL_Wait.c [VC_K20DT2M_8VAPS_Driver...]
@ < Back Next > Finih
Exit &/ bac I L FEinis
4 I, 3
Mo project focused, filtering disabled

Figure 9. Importing an Example File (a)
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2. Click Browse and locate the folder wherewith unzipped downloaded example files are located. Find the folder
MC34ValveController_PEx_SW\KDS_Examples and select a project to import. (see Figure 10, which shows
VC_K20D72M_4VAPS_DriverControl as the imported project). Then click OK.

# Import

Import Projects

@ Select root directory:
() Select archive file:

Projects:

Select a directory to search for existing Eclipse projects.

Browse For Folder

Options

[] Search for nested projects
[¥] Copy projects into workspace
[] Hide projects that already exist in the workspd

Waorking sets

[ Add project to working sets

Select root directory of the projects to import

Compenents

4 | KDS_Examples

< n

4 || MC34ValveController PEx SW -
CodeWarrior_Examples

+| | VC_K20D72M 4VAPS DriverControl
VC_K20D72M_4VAPS_DriverMonitoring
> 1L VC_K20D72M_4VAPS_FlutterCurrent -

Folder: VC_K20D72M_4VAPS _DriverControl

Make New Folder

T [

Cancel

Figure 10. Importing an Example File (b)

3. With the project now loaded in the Select root directory box, click on the Copy projects into workspace check box. Then click
Finish. Figure 11 shows the Projects panel and the Components panel after the project has been successfully imported. The
project is now in the Kinetis Design Studio workspace where it can build and run.

 Import

Import Projects

Select a directory to search for existing Eclipse projects.

@ Select root directory:  Z:\Projects\ValveControllerd, Execution Phi =

ol

[~ Search for nested projects

e projects that already exist in the workspace

Working sets
[] Add project to working sets

) Select archive file: Browse..
Projects:
Select All
Options

L5 Project Explorer £2 =
» =% VC_K20D72M_4VAPS DriverControl:

5. Components - VC_K20D72M 4VAPS DriverControl 52 = [
e v
4 (= Generstor_Configurations
@ RaM
@ FLASH
> = 0Ss

4 (= Processors
> &) CpuMK20DX256VLLY
> @ Cpu:MK20DX256VLLT

4 (= Components
> (= Referenced_Components
» 8% VCL:MC34ValveController
» 18 CsI01: Consolel0

> (= POD

Figure 11. Importing an Example File (c)
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4.3 Creating a New Project with Processor Expert and the

MC34ValveController Components

If choosing not to use the example projects, the following instructions describe how to create and setup a new project using the
MC34ValveController components. If the MC34ValveController does not have components in the Processor Expert Library, follow steps
in Section 4.2.1, Import the MC34ValveController Components into the Processor Expert Library, page 16.

To create a new project do the following:

% C/C++ - Kinetis Design Studio - C:\Users\b32384\workspace kds_300_valve -

1. In the Kinetis Design Studio menu bar, select File -> New -> Kinetis Project. When the New Kinetis Project dialog box opens,
enter a project name into the text box and then click Next. (see Figure 12).

File | Edit Source Refactor Mavigate Search Project Run  Processor Expert Window Help

Figure 12. Creating a Kinetis Project

New Alt+Shift+N » I% Kinetis Project g

Open File... {) Embedded Component Access

Close Ctl+W | [E¥] Makefile Project with Existing Code

Close All Ctrl+Shift+W | £ C++ Project

Cules || New Kinetis Project e

Save As... T -

Create a Kinetis Project

Save A Ctrl+Shift+5 .

=l IEShilt Choose the location for the new project

Revert

Move... Project name: | Examplef

Rename... F2

Refresh E5 [¥] Use default location

Convert Line Delimiters To 3 C:/Users/b52384/workspace.kds_300_valve/Example Bro

Print... Ctrl+P default

Switch Workspace 3

Restart = N
w  Import... -
i~y Export..

2.In the Devices dialog box, select the MCU class for the appropriate MCU. In Figure 13 MKL25Z128 has been selected. Then click

3.In the Rapid Application Development dialog box, make sure that the Processor Expert option is selected. Then click Next.
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4.In the Processor Expert Target Compiler dialog box, select a compiler to use (GNU C Compiler in Figure 13) and click Finish.

# New Kinetis Project B % ]
Devices J# New Kinetis Project uﬂ&”
Select the derivative you would like to use Rapid Application Development . Mew Kinetis Project o]
SDK, P Expert .
Processor to be used: K, Processor Bxpe Processor Expert Target Compiler
type filter text Target compiler
. Boards Kinetis SDK | None
4 Processors Target compiler
> Kinetis E - — GNU C Compiler
. Kinetis K nvironment variable IAR ARM C Compiler
4 KinetisL @ Absolute path Keil ARM C/C++ Compiler
> MKLOx
> MKLLx
o M
» KL24Z (48 MHz)
4 Kl 48 hH Start with perspective designed for
MIL2571 283006 () Hardware configuration (pin muxin|
MEKL2523 25004 @ Use current perspective
MEKL25 28400
Initialize all peripherals
Creates project for MKL2571 280t derivative Praject Mode
) Linked
(@ Standalone
If this project is expected to use the Kinetis 5D
Kinetis SDK into this tool using Help -> Install
— your Kinetis 5DK folder to find the appropriate]
(‘_?,.' < Back I Next > p -
= Enable Processor Expert in the project for MC
initialization.
« n
':?:' < Back l Mext > N
(?:' Next » l Einish R]{ Cancel ]

Figure 13. Selecting a Device, the Rapid Application Development Options and Compiler

5. Figure 14 shows the Projects Explorer panel and the Components panel after the project has been successfully created.
Before the project can be built and run, add the component (imported in Section 4.2.2, Importing an Example Project into Kinetis Design

Studio, page 18) into the project. Section 4.3.1, Adding a MC34ValveController Component into the Project, page 22 outlines this
procedure.

LD Project Explorer §3 = B8
-
» |25 Example]
7. Components - Example 52 = 8
B -
a (= Generator_Configurations
&b FLASH
> (= OSs

4 (= Processors

s Q CpuMKL25Z128VLK4
» (= Components
. (= PDD

Figure 14. Project Explorer and Components Panels with Project Created
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4.3.1

Adding a MC34ValveController Component into the Project

1. Find the MC34ValveController component in the Components Library and add it into the project (see Figure 15). It is located in
the workspace directory selected when importing the component (My Repository in the example).

% C/C++ - Kinetis Design Studio - C\Users\b52384\workspace.kds_300_valve

|= | B |t

File Edit Source Refactor Mavigate Search Project Run ProcessorExpert Window Help
E | ®~R~ &N e B e aa P LN it e
B 8 e = Quick Access |:| B | [ C/C+ | 5 Debug
[ Project Explorer 52 =0 Component Inspector - Cpu Components Library 52 Ef v ]
P B P! P y
== -
. 5 Example Alphabetical | Categories . Processors | Board Configurations
T Al repositories ~ || Applicable to project =
p: ppl proj
Component Description
« i 3 » & BC
- » = Kinetis
. Components - Bample &3 = » > Legacy User Components
= ‘b B v » (= My Components
4 (= Generator_Configurations 4 (= My Repositary
B FLASH a (= Software
. [ 0Ss 4 (= User Components
4 (= Processors MC34V5.IveCuntroHer B Addto project 10 and MC345B0800
) CpuMKL25Z128VLKS SP1_Device A e pus
ve Add to project with Wizard
» = Components =
(= PDD Expand all
Collapse all
Filter on for MKL25Z128VLK4 (Example) | 3§ Delete Delete |
Copy To..

Figure 15. Add the MC34ValveController Component to the Project

2. Figure 16 shows the Components panel after the component was added. To view the Component Inspector options,
double-click on the MC34ValveController component in the Components panel.

% C/C++ - Kinetis Design Studio - C\Users\b52384\workspace kds_300_valve =Npen X

File Edit Source Refactor Navigste Search Project Run ProcessorExpert Window Help
PSP R el HORSARSCRACRIE R A TR A RSN Rt s
7 8 e e Quick Access

[ Project Explorer 33 = O $) *ComponentInspector - VC1 57 4 [Basic Jadvanced 5 <o =8
==
=1 Properties . Methads| Events
£ Bxample
Name Value Details -
Component Name vcl
a Valve Controller Model MC24580410
4 General Settings
SPI Device Link My Repositary/SPI_Device
Reset Pin PTEL/SPIL_MOSI/UARTL_RX/SPIL_MISQ...
Clock Frequency Fixed
Internal Clock Menitoring Enabled
4 LSD for Inductive Loads
3 - : Rize Time and Fall Time Long
Open Load Detection Enabled E
©5. Components - Example 52 =l a 4 PWM Frequency
S E - Frequency of LSD1-4 39 kHz
4 Current Regulation Mode
4 (= Generator_Configurations 4 PlRegulator
B FLASH P - Characteristic 1
& 0% - Characteristic 0425
4 (& Processors Integrator Limit Low
P CpuMKL25Z128VLKe Minimum PWM Duty 10%
4 & Components First PWIM Duty Controlled by Current

. B Referenced_Components

. [ VCI:MC34ValveController . [I;[:tfr Fromuensy Settihg: e
& PDD Masximum Current 5000 500 mA
4 ‘Control Mode Current Regulation
Target Current 0.0 Rounded value: 0
Flutter Frequency Disabled
a LsD 2
Maximum Current 5000 500 mA
4 ‘Control Mode C gulation The mode is cont
Target Current 0.0 Rounded value: 0
Flutter Frequency Disabled -
< I Sl K I 5

¥ VC1:MC3aValveContraller

| 65 | EEE) 0

=4
o
o=
@)

SR

&

Figure 16. Show the Component Inspector
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4.4  Setting up the Project

Once the new project has been created and the MC34ValveController component has been added into it, the component properties in the
project must be set up. Make sure to read Section 3.1, Component Settings, page 7, which describes the component’s capabilities and

what must be done to configure its properties.

MC34ValveController uses several components (see Figure 17). Configure all the components in the following order:
1. Set up the MC34ValveController component.
2. Set up the referenced SPI_Master_LDD component.
3. Set up the CS pin under the inherited SPI_Device component.

5. Components - Exarmple 232 = |m

B FLaH
» (= 05s
4 (= Processors
. &) CpuMKLI5Z128VLK4
4 [ Components
4 (= Referenced_Components
> ﬂ SM1:5PIMaster_LDD[SPImaster]
4 3 VC1:MC34ValveController
a SPI_Devicel:SPI Device
@ CSpinl:Bitl0_LDD
@4 RSTBL:BIIO_LDD
H] Init
M Deinit
[H] WriteRegister
H] ReadRegister =

m

Figure 17. Setting up the Components

4.5 Generating Driver Source Code

After having completed configuring the components, the application is ready to generate the driver code to be incorporated. The process
is as follows:
1. Click on the Generate Processor Expert Code icon in the upper right corner of the Components panel.

5. Compoenents - Example &2 = 8 [ Project Explorer 23 — \'_"{-, |

- ‘b - a % Example
4 [= Generator_Configurations ! Includes
& FLASH
= OSs
4 [~ Processors

. &P CpuMKLZSZ128VLKe

» (= Documentation
- = Generated_Code
- = Project_Settings
4 |[= Sources

4 [= Components - \g| Events.c
- [ Referenced_Components - Lh| Eventsh
- g main.c

- % VCL:MC34ValveController

= PDD . (= Static_Code

% ProcessorExpert.pe
=] ProjectInfo.xml

Figure 18. Generating the Source Code and Code Location
2. The driver code for the device is generated into the Generated_Code folder in the Project Explorer panel. The component only

generates the driver code. It does not generate application code. Figure 18 shows the locations of the generated driver source
and the application code.
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4.6 Writing the Application Code

All of the application code must reside in the Sources folder in the project directory. The code may modified in main.c and Events.c, but
retain the original comments related to usage directions.

To add a component method into the application source code:

1. In the Components panel for the project, click on Components. Find the desired method to add to the code.
2.Drag and drop the method directly into the source code panel.

3. Add the appropriate parameters to the method. Hovering the mouse over the method displays a a list of the required parameters.

For example, open the MC34ValveController component method list, drag and drop ReadRegister into main.c and add the necessary
parameters. (See Figure 19).

# C/C++ - Example/Sources/main.c - Kinetis Design Studio - C:\Users\b52384\workspace.kds_300_valve == =
File Edit Source Refactor Mavigate Search Project Run Processor Expert Window Help
RS R G e e e e e O Qe Qe e
MW g Wit -5l Quick Access i| % | [EFC/Cew | 4 Debug
Iy Project Explarer &2 ~ B £y ComponentInspector .. £y Components Library [g maine iz | T B 75,
o - 5 wADLIUME  Fo_iypEse =
5| 48 #include r.h" e =
4 i Bxample - 41 #include " onst.h" ®
> Includes | 42 #include "IO_Map.h"
> (= Decumentation 1| 43 User includes (#include below this line is not maintaine El
. [ Generated_Cod ot i
& Generated Code /*lint -save -e978 Disable MISRA rule (6.3) checking. */ =
» [= Project_Settings int main(void) =
a BEDUVCES f*lint -restore Enable MISRA rule (6.3) checking. */ al
o | Events.c { &
o Events.h /* Write your local variable definition here */ =]
. |£| T uintls_t RegPtr; g
d i L PE_low_level init(); =
* End of Processor Expert internal initiaz lization.
w5 Compenents - Example 52 = 8 =
= /* Write your code here */
- % & /* For example: for{;;) { } */
4 (= Generator_Cenfigurations
@ FLASH IVEl_ReadREgister(l, &Regptr);l
> (= 0%s
4 (> Processors * E?w;’ ite anydccde passpz:i;{.inz% :T’ i df- b: E
) * RTO! tup code. Macro PEX_RTOS _START is defined b
» @ CpuMKLISZLBVLK #ifdef PEX_RTOS_START E
4 (= Components PEX_RTOS_START(); /* Startup of the se
: (= Referenced_Components #endif
4 g VC1:MC34ValveController e of RTOS startup code.
. SPLDevlcﬂ:SPLDewce ssor Expert end of main routine. DON'T MODIFY T|
EI RSTBL:BHIO_LDD Expert end of mai outine. DON'T WRITE COQ
H Init in routine. DO NOT MODIFY THIS TEXT!!l **+/
M Deinit
M| \\riteRegister
M ReadRegister
M Getlontrollerdtatus v 75 s -
B n b 4 ] +
Writable Smart Insert 58:3 =

Figure 19. Adding Component Methods

Hovering the mouse over any of the methods displays a description of the method, including a list of required parameter.

The MC34ValveController component encompasses a help, which describes component properties, methods and typical usage. To show
the help, do the following:

1. In the Components view, right-click MC34ValveController component and select Help on Component.
2. A web page with the Help information displays.
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4.6.1 Compiling, Downloading and Debugging

To compile a project, click on the compile icon in the tool bar (see Figure 20).

S C/C++ - Example/Sources/main.c - Kinetis Design Studio - C\Users\b52384\workspace.kds_300_valve l B S
File Edit Source Refactor MNavigate Search Project Run

Processor Expert  Window  Help

- | ® wiw|E e O
e HemB ol & : - . b b Quick Access i%“i’;Debug

75 Project Explorer 52 =8 [& maine 32 ™1 = B8 5.
S-S 4¢  #include "PE_Error.h” . £
» 125 Example 41 #include "PE_Const.h" =
- 42 #include "I0 Map.h" ©
43 * User includes (#include below s line is no E|
= - /*1int -save -e97@ Disable MISRA rule (6.3) che
ts. Components - Exa... B2 ] main(void)
=i ‘b B v i -restore Enable MISRA rule (6.3) checking =g
4 [ Generator_Cenfigurations local variable definition here * =
B FLASH < I 3
» = 0Ss
4 (= Processors I#! Problems = Tasks B Console 52 [ Properties = |ml

+ 4 Cpu:MKL25Z128VLKA
4 [ Components

LB EFE & B

CDT Build Console [Example]

» (= Referenced_Compenents DULLULME LdfgEL: CAAMpLE.ELi 5
. 9 VCLMC38ValveControlley | voking: Cross ARM Cit Linker
= PDD arm-none-eabi-g++ -mcpu=cortex-m@plus -mthumb -08 -fmes| |
> =

"Finished building target: Example.elf’
A

2

Figure 20. Compiling the Application

The process for downloading an application on board in Kinetis Design Studio may differ according to MCU board used. For any questions,
see the Kinetis Design Studio user's guide.

To download and debug on TWR-KL25Z48M MCU board, do the following:

1. Click the arrow next to the debug icon in the tabular and select Debug Configurations... (see Figure 21)

[ C/C++ - Example/Sources/main.c - Kinetis Design Studio - C:\Users\b52384\workspace kds_300_valve = | B [ )
File Edit Source Refactor Navigate Search Project Run Processor Expert Window Help
= e K B E@vﬁzva@;vso.gg.qﬁ.
BO T ! x > hd - Quick | (ne launch history)
I Project Explorer 22 = 8 S Debug As [ =
= <;==$ ¢ v #include "PE_Error.h” Dehuo Configyrations I,\\)
» % Bample #include "PE_Const.h™ Organize Favorites...

#include "IO Map.h"
User includes (#include below this line is not m

& *lint -save -e97@ Disable MISRA rule (6.3) checki
%5 Components - Exam.. 22 = 0O . : . (6.3)

int main{void) =

- & B - lint -restore Enable MISRA rule (6.3) checking. =
4 [= Generator_Configurations i i local variable definition here =/ =
#i FLASH o \
> = 0%
4 (= Processors |#] Problems =] Tasks [ Console I |[C] Properties = B

. @ CpuMKL25Z128VLKY
4 (= Components

G oE) BT & B rE

CDT Build Console [Example]

. [= Referenced_Components DULLULIE tal ot CAGINPLE.SLl N

. 158 VCLIMC3M4ValveController Invoking: Cross ARM Crt Linker |

. POD arm-none-eabi-g++ -mcpu=cortex-m@plus -mthumb -0@ -fmessag:_“_g

o= 'Finished building target: Example.elf’ -
PR

Figure 21. Downloading the Application (a)

2. In the Debug Configurations dialog box, click Example_Debug PNE under GDB PEMicro Interface Debugging (see Figure 22).
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3. Make sure that C/C++ Application contains a path to the .elf file of the project (see Figure 22).

Create, manage, and run configurations _
X IEE

Name: Example_Debug_PNE

typefilter text [E Main| %% Debugger B+ Startup| B~ Source| [ Common
[E] €/C++ Application

[T] C/C++ Attach to Application Broject

[T] C/C++ Postmortem Debugger Example
[E] C/C++ Remote Application

[£] GDB Hardware Debugging Specify the number of additional EIf Files you wish to program:
[T ] GDE OEEHOCD Debugging C/C++ Application:

GDB PEMicro Interface Debugging
& | Example Debug PNE]

GDB SEGGER J-Link Debugging

= Launch Group

% Debug Configurations Lé]
o

Cif7]

| Debug/Example.elf

FL

Variables... ] [Searcﬂ Project...l l Browse... I

Build (if required) before launching

Build configuration: | Use Active VI

") Enable auto build " Disable auto build

@ Use workspace settings Configure Workspace Settings...

Filter matched 16 of 28 items AP el

Figure 22. Downloading the Application (b)

4. Click the Debugger tab and set Interface option to OpenSDA Embedded Debug - USB Port. Then click Refresh button next to
the Port setting to update list of available USB ports (see Figure 23).

5. Make sure the Target is set to KL25Z2128M4. If not, change the target with use of the Select Device button. Click the button, in
the Select Target Device dialog box go to Freescale -> KL2x -> KL25Z128M4 and confirm with the Select button.

6. Click Debug. Kinetis Design Studio will download and launch the program on board.

# Debug Configurations &J

Create, manage, and run configurations

i\, Plugin has not been registered. Some functionality may not be available. ﬁ\’

2% B - Name Example_Debug_PNE

type filter text [E] Main|%5 Debugger | Startup | - Source| ] Commen

[E] C/Co+ Application
[E] C/C++ Attach to Application
(5] C/C+ + Postmortem Debugger Please register your software to remove this message.
[£] ©/C++ Remote Application L
[E] GDB Hardware Debugging

, [£] GDB OpenOCD Debugging

[£] GDE PEMicro Interface Debugging

Software Registration s

m

PEMicro Interface Settings

S

2] Example_Debug_PNE Interface: OpenSDA Embedded Debug - USB Port + BCompatible Hardware
» [£] GDB SEGGER J-Link Debugging Port: USBL - OpenSDA (OpensSDA) = resees ||
[ Launch Group
Vendor: Freescale Family: KL2x Target: KL25Z128M4
Core: MO 2
Specify IP Specify Netwark Card IP

Additional Options

Filter matched 16 of 28 items Apply

Figure 23. Downloading the Application (c)
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5 References

Following are URLs where you can obtain information on related NXP products and application solutions:

Table 8. References

References

NXP.com Support Pages

Description

URL

MC34SB0410

Product Summary Page

www.nxp.com/MC34SB0410

MC34SB0800

Product Summary Page

www.nxp.com/MC34SB0800

TWR-SB0410-36EVB

Tool Summary Page

www.nxp.com/TWR-SB0410-36EVB

TWR-SB0800-36EVB

Tool Summary Page

www.nxp.com/TWR-SB0800-36EVB

Tower System

Tower System Modular
Development Board
Platform

WWW.nxp.com/tower

Kinetis Design Studio

Software

www.nxp.com/kinetis

CodeWarrior

Software

www.nxp.com/codewarrior

Processor Expert Code
Model

Code Walkthrough Video

www.freescale.com/video/processor-expert-code-model-codewarrior-code-walkthrough:PR
OEXPCODMODCW_VID

5.1 Support

Visit www.nxp.com/support for a list of phone numbers within your region.

5.2

Warranty

Visit www.nxp.com/warranty to submit a request for tool warranty.
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www.nxp.com/warranty
www.nxp.com/MC34SB0800
www.nxp.com/products/discretes-and-logic/mosfets/low-side-switches/octal-valve-controller-system-on-chip:MC34SB0800?lang_cd=en
http://www.nxp.com/products/discretes-and-logic/mosfets/low-side-switches/quad-valve-controller-system-on-chip:MC34SB0410
http://www.nxp.com/products/discretes-and-logic/mosfets/low-side-switches/quad-valve-controller-system-on-chip:MC34SB0410
http://www.nxp.com/TWR-SB0410-36EVB
www.nxp.com/TWR-SB0800-36EVB
www.nxp.com/tower
www.nxp.com/kinetis
www.nxp.com/codewarrior
www.freescale.com/video/processor-expert-code-model-codewarrior-code-walkthrough:PROEXPCODMODCW_VID
www.freescale.com/video/processor-expert-code-model-codewarrior-code-walkthrough:PROEXPCODMODCW_VID
http://www.nxp.com/support/sales-and-support:SUPPORTHOME
http://www.nxp.com/support/sales-and-support/buy-direct/returns-and-warranty-information:WTBUY_DTD_RETURNS?tid=vanwarranty
http://www.freescale.com/support
http://www.freescale.com/support
http://www.freescale.com/warranty
http://www.nxp.com/products/discretes-and-logic/mosfets/low-side-switches/quad-valve-controller-system-on-chip:MC34SB0410
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How to Reach Us:

Home Page:
nxp.com
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nxp.com/support

VRoHS

Information in this document is provided solely to enable system and software implementers to use Freescale products.
There are no express or implied copyright licenses granted hereunder to design or fabricate any integrated circuits based
on the information in this document.

Freescale reserves the right to make changes without further notice to any products herein. Freescale makes no
warranty, representation, or guarantee regarding the suitability of its products for any particular purpose, nor does
Freescale assume any liability arising out of the application or use of any product or circuit, and specifically disclaims any
and all liability, including without limitation consequential or incidental damages. “Typical” parameters that may be
provided in Freescale data sheets and/or specifications can and do vary in different applications, and actual performance
may vary over time. All operating parameters, including “typicals,” must be validated for each customer application by
customer’s technical experts. Freescale does not convey any license under its patent rights nor the rights of others.

Freescale sells products pursuant to standard terms and conditions of sale, which can be found at the following address:

http://www.nxp.com/terms-of-use.html.

Freescale and the Freescale logo are trademarks of Freescale Semiconductor, Inc., Reg. U.S. Pat. & Tm. Off.
SMARTMOS is a trademark of Freescale Semiconductor, Inc. All other product or service names are the property of their
respective owners.

© NXP Semiconductors N.V. 2016. All rights reserved.

Document Number: SB0410-SB0800SWUG
Rev. 1.0

A Y 4
A\


http://www.nxp.com/about/terms-of-use:TERMSOFUSE
http://www.nxp.com/support/sales-and-support:SUPPORTHOME
http://www.nxp.com/

	MC34ValveController Processor Expert Component
	1 Overview
	2 MC34ValveController Compatibility
	2.1 Peripheral Requirements
	2.2 Supported Devices
	2.3 Supported MCUs
	2.4 Tower Board Settings

	3 MC34ValveController Component
	3.1 Component Settings
	3.2 SPI Configuration
	3.3 Component API
	3.4 MC34ValveController Components
	3.5 Fault Detection and Handling
	3.6 Flutter Current Feature
	3.7 Known Issues

	4 Installing the Processor Expert Software
	4.1 Installing Kinetis Design Studio
	4.2 Downloading the Components and Example Projects
	4.2.1 Import the MC34ValveController Components into the Processor Expert Library
	4.2.2 Importing an Example Project into Kinetis Design Studio

	4.3 Creating a New Project with Processor Expert and the MC34ValveController Components
	4.3.1 Adding a MC34ValveController Component into the Project

	4.4 Setting up the Project
	4.5 Generating Driver Source Code
	4.6 Writing the Application Code
	4.6.1 Compiling, Downloading and Debugging


	5 References
	5.1 Support
	5.2 Warranty

	6 Revision History


